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I.  Introduction 
 
In this lab and the next, you will design, fabricate and test four Al resistors using some of 
the techniques that are employed to make integrated circuits.  First, we will evaporate a 
thin film of aluminum on a Si wafer.  Then you will use photolithographic techniques to 
pattern the film and etch away unwanted parts, leaving only your resistors.  In this week’s 
lab, you will complete the Al thin film deposition and mask design parts of the process.  
Next week, you will pattern the resistors and test them.   
 
Evaporation 

Evaporation is one of several methods that can be used to deposit a thin film on a 
substrate (see Appendix D for information on methods of physical vapor deposition).  We 
will deposit a 50 nm thick film of Al onto a substrate using thermal evaporation.  The 
substrate will be a silicon wafer with a 1 μm thick layer of silicon oxide to electrically 
insulate the resistors from the semiconducting silicon. 
 
We will place the substrate in a vacuum chamber and reduce the pressure to ~10-6 Torr 
(atmospheric pressure is 760 Torr).  In the low-pressure environment, we will heat a 
tungsten boat containing Al until the Al melts and begins to evaporate.  The aluminum 
vapor will condense on the relatively cold surfaces in the chamber, including the 
substrate.  A nearby sensor, the quartz crystal thickness monitor, will measure the 
thickness of the Al layer in real time and thus allow us to control the thickness (see 
Appendix D).  Once the deposition is completed, we will remove the substrate with the 
Al thin film and “cleave” or break it so that each team has a piece approximately 2.5 cm 
× 2.5 cm.  A detailed procedure for operating the evaporation system, including a 
diagram of the system, and can be found in Appendix E.  Appendix F describes the how 
the vacuum pumps work. 
 
Photolithography 

Photolithography is the primary method used to pattern devices in the manufacture of 
integrated circuits.  In today’s fab lines, it is used to make features smaller than 0.1 μm 
(100 nm).  A major advantage of photolithography is the ability to fabricate many devices 
at once (i.e. in parallel), making possible the production of very complex circuits in a 
relatively short time.  A fundamental limitation of photolithography is diffraction, which 
limits the size of the features that can be made to approximately the wavelength of the 
light used. 
 
In photolithography, a uniform layer of photoresist is applied to a surface to be patterned.  
Ultraviolet (UV) light is shown on a mask positioned above the surface.  Some regions of 
the mask are transparent to the UV light and allow exposure of the photoresist below 
while other regions are opaque and block the UV (see figure below).  
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Exposure to UV light alters the chemistry of the photoresist and changes its solubility 
relative to unexposed resist.  There are two types of resist, “positive” and “negative.” 
When a positive resist is exposed to UV light, the energetic photons of the light break 
certain bonds in the long-chain polymers of the resist, causing them to become shorter 
and thus more soluble.  A developer easily washes away the exposed areas, leaving 
behind a copy of the pattern on the mask.  When a negative resist is exposed to UV light 
it causes cross-linking between the resist polymers making the exposed areas less soluble.  
The developer removes the exposed resist, leaving behind a negative image of the mask. 
 
After development, some parts of the Al film will be exposed while other regions will be 
protected under a layer of photoresist.  Next, an acid or “etchant” will be used to remove 
the metal where it is exposed.  The resulting pattern of metal lines will correspond closely 
to the original pattern on the mask.  To remove the remaining photoresist, a variety of 
solvents can be used.   
 
Cleaving 

Each silicon wafer is a single crystal of silicon.  For such a single crystal, there are 
certain directions along which the silicon breaks, or cleaves, easily.  On a microscopic 
level, the density of chemical bonds per square centimeter is lowest along the crystal 
planes that separate most easily.  For silicon, there are four orthogonal sets of planes that 
cleave easily to make dicing the wafer into square or rectangular pieces relatively easy 
(for <100> wafers).  A diamond-tipped scribe can be used to etch a line in the silicon and 
weaken the wafer in that location.  Gentle applied pressure will cause the wafer break, 
usually along the desired cleave line. 
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II.  Procedure 
 
A.  Al deposition 

1.  Watch the demonstration of evaporation of an Al film on your Si wafer.  (Appendix E 
contains the steps of the evaporation.) 

2.  Record the thickness of the Al film deposited. 

3.  Take notes as necessary for answering questions 1-3 in the Analysis section. 
 
B.  Mask Design 

Your task is to design a mask for patterning four resistors in a 50 nm thick Al film.  Note 
that bulk Al has a resistivity of 2.65×10-8 Ωm.   

1.   Mask design parameters: 
 a.   Two resistors will be 100 µm wide with resistances of 20 Ω and 40 Ω. 
 b.   Two resistors will have a width of 200 µm and resistances of 20 Ω and 40 Ω. 
 c.   All resistors must fit within a 2 cm × 2 cm area.   
 d.   The end of each resistor will be terminated by a 2 mm × 2 mm contact pad. 
 e.   Any thin lines should be oriented horizontally to avoid problems due to the poor 

vertical resolution of inkjet printers. 

2.  Mask planning 
 a.   To establish the lengths of your resistors, work through question 4 in the Analysis 

section.  Round your answers to the nearest 100 µm for ease of design. 
 b.   To establish the “tone” of your mask, work through question 5 in the Analysis 

section. 

3.   Start mask design program 
 a.   From the list of programs, open Intellisuite>>Intellimask. 
 b.   In the View menu open View Editor and choose a window with lower left corner 

(0, 0) and upper right corner (10000, 10000).  Choose a grid spacing of 100 µm. 

4.   Some commands you will probably find useful are listed below: 

 a.   To draw a rectangle, choose the Create Rectangle tool   and click, drag and 
release the mouse to indicate location and size of rectangle. 

 b.   To delete an object, first select it using the Select Figures tool  then hit the 
Delete key. 

 c.   To copy an object, use the 1-Copy Translate button . 

 d.   To view region that is off your screen, choose the Pan tool  and drag the 
background to a new location. 

 e.   To move the axis, which is helpful when creating new objects of the right size, 

choose the Reset Origin tool  
 f.   To undo your previous step, choose Undo from the Control menu 
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5.   Prepare design for printing 
 a.   In View menu select Coordinate Axes so that they are not visible. 
 b.   In View menu select Polygon Boundary so boundaries are no longer visible. 
 c.   In Layer menu choose Layer Editor>>Modify>>Select Color and highlight black. 

6.   Print enlarged version of mask on paper 
 a.   In View menu select Fit All Objects 
 b.   Go to File>>Print... and select inkjet printer HP Officejet Pro K550 
 c.   Print one copy for each person on your team. 

7.   Scale mask 
 a.   Measure length of one side of a bonding pad on enlarged printout. 
 b.   Compute scaling factor by dividing desired length by length on enlarged printout. 
 c.   In Layer menu choose Select to highlight all objects in layer. 
 d.   Choose Layer>>Rescale and click on background.   
 e.   Enter rescale factor and hit OK. 
 f.   Deselect all objects by choosing Layer>>Deselect. 

8.   Print 1:1 scaled version of mask on paper 
 a.   In Print dialog box, be sure that the inkjet printer is selected. 
 b.   Print one copy for your team. 
 c. Use a scale loupe to check the dimensions of your scaled design. 

9.   Print 1:1 scaled version of mask on transparency 
 a.   In Print dialog box, be sure that the inkjet printer is selected. 
 b.   From Print dialog box, click on Properties...  
 c.   Click on the Paper/Quality tab.  Check that Type is Plain paper.  (Do not select 

inkjet paper, or ink will not be dense enough.)  Choose Best for Print Quality. 
 d.   Ask other groups to suspend printing until you are finished. 
 e.   Load an inkjet transparency in the top tray of the inkjet printer with the white strip 

with words facing up and towards the printer.  Print one copy per team. 

10.  Check your mask 
 a.   Examine all parts of your mask with a 10X scale loupe. 
 b.   Check that all dimensions match your design.  Look for and note any defects. 
 c.   If you see a discontinuous line or some other major defect, check with your TA 

about making another mask. 
 d.   When finished, hand your mask to your TA to keep for next week. 
 
C.  Cleave wafer 

Each team will need a 1” or 2.5 cm square chip of silicon coated with Al.  To prevent the 
chip from being contaminated by you or the environment, always wear nitrile gloves 
when handling your chip and handle your chip with wafer tweezers, not your hands.  
Take care to avoid damage to the Al film.  It is best to always pick up your chip in the 
same place. 

1. Place wafer Al side down on a clean-wipe. 
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2. Using a diamond-tipped scribe, scratch a line where you want the wafer to break.  A 
glass slide can be used as a straight edge.  It is best to align the cleave line along a 
crystalline axis of the silicon wafer. 

3. Place two glass slides on top of each other, then slide the Si wafer between them so 
that the scribed line is at the edges of the glass slides. 

4. Press down on glass slide sandwich to hold the Si wafer in place, then press down on 
other side of the wafer until it breaks, hopefully along the line you scribed. 

5. Use compressed air to remove unwanted particles on the Si wafer from cleaving 
process.  

6. Place your chip, Al side down, in a chip carrier and label the carrier with your names, 
the date, and the sample inside. 
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III.  Analysis 
 
1.   Explain why a vacuum is necessary for evaporation and deposition of Al on the 

wafer. Give a brief description of how the diffusion pump and the mechanical pump 
create the necessary vacuum.  

2.   Explain how the Al is heated for evaporation.  

3.   Write the thickness of the Al film on your wafer with the appropriate number of 
significant digits.  Explain how the crystal monitor measures the thickness of the Al 
film is monitored during deposition. 

4.   Given an Al film thickness of 50 nm and Al resistivity of 2.65×10-8 Ωm, calculate the 
lengths necessary to make resistors of 20 Ω and 40 Ω assuming a width of 100 µm.  
Repeat for a 200 µm width.  Note that a resistor will have a resistance R given by 

AlR ρ=  where ρ is resistivity, l is length, and A is cross-sectional area.  Show your 
work.   

5.   Referencing the diagram in the Introduction, sketch subsequent diagrams showing the 
wafer: (i) after development, (ii) after Al etching, and (iii) after resist removal.  Do 
this for the case of a positive resist and for the case of a negative resist.  Should your 
resistor pattern be opaque or transparent to the UV light given that you will use a 
positive resist for patterning (this is the “tone” of the mask)? 

6.   Attach a printout of the enlarged version of your mask.  Label the dimensions of your 
resistors on the enlarged version as if it were the 1:1 version.   

7.   Sketch a design for a 200 Ω Al resistor (including 2 mm × 2 mm contact pads) that is 
50 nm thick, 100 µm wide and fits in a 2 cm × 2 cm area.  Label dimensions. 
 

 12 



 
APPENDIX D 

Physical Vapor Deposition 
 
Making thin, uniform films of materials is a basic task in nanoscale science and 
engineering.  Three physical methods of depositing thin films are described below. 
 
Evaporation 

The simplest way to make a thin film is to 
evaporate material in vacuum and allow its 
vapor to deposit on a substrate.  A “boat” 
typically made of tungsten, which has a high 
melting point, has a little dimple into which the 
material to be evaporated is placed.  The boat is 
heated in vacuum to a high enough temperature 
so that the vapor pressure of the evaporated 
material is appreciable, and the vapor is 
allowed to condense on a “cold” substrate.    
“E-beam” evaporation is a variation in which 
electrons are accelerated and directed at the target material, causing it to heat up.  This 
technique allows more precise control of deposition rates and film composition. 
 
Molecular beam epitaxy (MBE) 

Thin layers of materials can be made by a 
sophisticated beam evaporation system 
shown schematically in the figure at right. 
Three or more crucibles containing 
material to be evaporated can be 
maintained at different temperatures.  
Shutters are opened or closed for an 
appropriate interval of time to allow 
vapors of different materials or 
combinations of materials to be deposited 
on a substrate that is at a controlled 
temperature.   
 
Sputtering 

In sputtering, atoms are removed from one 
surface by energetic ion bombardment and 
allowed to collect on another surface. 
Noble gas ions, typically argon, are used to 
bombard the surface of the material from 
which one wishes to make a thin film. 
Incident ions with large kinetic energy 
collide with surface atoms and give them 
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enough kinetic energy to leave the surface and travel to the substrate.  It is somewhat like 
shooting cannon balls at a cement wall causing chunks to fly off.  Eventually the 
sputtered atoms accumulate in a layer on the substrate, forming a thin film.  
 
Quartz crystal monitor 

A quartz crystal thickness monitor is frequently used to determine film growth rate and 
instantaneous thickness in physical vapor deposition processes.  In our lab, a quartz 
crystal sensor is positioned near the Si substrate so that Al atoms also condense on the 
surface of the quartz crystal.  The increase in the mass of the sensor is converted to a film 
thickness by the electronic control unit.  The deposition of the Al film is stopped once it 
reaches the desired thickness, as displayed by the control unit. 

When electrically energized, quartz crystals resonate or produce an alternating electrical 
current at a stable, well-defined frequency.  This is the basis of their use in timepieces.  
There are two quartz crystals in the crystal monitor, one in the sensor and one in the 
control unit.  The control unit counts the number of oscillations per second from each 
crystal and determines the difference.  The initial frequency difference before the film is 
deposited can be stored by the control unit and used to “zero” the readout. 

As the evaporation proceeds, the substrate and the sensor (usually positioned the same 
distance from the source) are coated with atoms.  The coating increases the mass of the 
sensor, which causes the frequency of its crystal to decrease.  Meanwhile, the frequency 
of the crystal inside the control unit remains unchanged.  The control unit compares 
current frequency difference to the initial frequency difference, and computes the 
increase in mass of the sensor.  Using information already programmed into the 
instrument, including the exposed area of the sensor crystal and the density of the 
deposited film, the control unit computes and displays the thickness of the material 
deposited on the sensor. 

The quartz crystal thickness monitor has the advantage of allowing the evaporation 
process to be controlled in real time.  However, it is typically not as accurate as 
instruments that directly measure film thickness, such as a surface profilometer or an 
atomic force microscope.  For example, variations in deposition conditions can cause a 
change in film density, which affects the accuracy of the thickness determined by the 
crystal monitor. 
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APPENDIX E 
Evaporation Procedure 
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Pre-pump down 

1. Put on gloves for work inside the chamber 
2. Place Al source in W boat. 
3. Put shielding tube over boat to prevent excess deposition on glass cylinder. 
4. Clip substrate on substrate holder. 
5. Put glass cylinder on Al base and center it (make sure seals are clean). 
6. Put implosion shield over glass cylinder. 
7. Put Al top on glass cylinder and center it. 
8. Put substrate holder on Al top and center it. 
9. Attach coaxial cable to crystal monitor. 
10. Close chamber vent valve. 
11. Turn on power strip for gauges and sensors. 

 
Pump down A: if chamber and pumps at atmospheric pressure 

1. Turn on cooling water for diffusion pump. 
2. Make sure gate valve is closed. 
3. Open foreline and roughing valves. 
4. Check that hood is on to exhaust rotary pump fumes. 
5. Close vent valve on foreline. 
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6. Plug in rotary pump to turn it on. 
7. When thermocouple gauges both read < 50 mTorr, close roughing valve, turn on 

both diffusion pump switches, and press black interlock button on same panel.  
Check that lights are on for both switches. 

8. Add liquid nitrogen to cold trap.  When trap is full and the diffusion pump has 
been on for 20 minutes, then open gate valve if chamber is <50 mTorr.  (If 
needed, first close foreline valve and open roughing valve to get chamber pressure 
below 50 mTorr.  Then reclose roughing valve and reopen foreline valve.) 

9. Wait 5 minutes after the thermocouple gauge reads 0 mTorr, then turn on the ion 
gauge.  Push “Standby” to turn on, then push “Emis.”.  Ion gauge should glow. 

 
Pump down B: if diffusion and rotary pumps on, chamber at atmospheric pressure 

1. Close foreline valve. 
2. Open roughing valve. 
3. When thermocouple gauge on chamber reads below 1000 mTorr, close roughing 

valve. 
4. Open foreline valve. 
5.  Open gate valve. 
6. When thermocouple gauge reads 0 mTorr, then turn on the ion gauge.  Push 

“Standby” to turn on, then push “Emis.”  Ion gauge should glow. 
 
Evaporate 

1. When the pressure is below 1.0×10-5 Torr, it is OK to evaporate Al. 
2. Turn on the power to crystal monitor by pressing “Power”. 
3. Check film settings by pressing “PG” key.  Page 4-7 in the manual contains 

settings for bulk density and z-ratio.  Enter new values if needed using the “E↓” 
key to scroll down and the numerical keypad for entry. 

4. Hit “zero” to zero film thickness. 
5. Check that the “front” boat is selected. 
6. Check that the transformer dial on the lowest panel is set to the position of the 

black arrow. 
7. Make sure the current dial on the second lowest panel is at its lowest setting.  

Turn on the power switch. 
8. Press “start” on the crystal monitor. 
9. Slowly turn up the current until the boat is glowing and the Al begins to melt. 
10. Turn down the current so that the Al melts slowly. 
11. Gradually turn up the current to about 100A to get an evaporation rate of 10—20 

Å/sec. 
12. Turn the current to zero when desired film thickness is reached. 
13. Turn off crystal monitor and power to boat. 

 
Vent A:  leave pumps running, vent chamber only 

1. Wait 5 minutes for boat to cool. 
2. Turn off the ion gauge. 
3. Close the gate valve. 
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4. Open chamber vent valve. 
 
Vent B:  vent chamber and pumps 

1. Wait 5 minutes for filament to cool. 
2. Turn off the ion gauge. 
3. Close the gate valve. 
4. Turn off diffusion pump (both switches). 
5.   Open chamber vent valve. 
6. Close foreline valve. 
7. Turn off mechanical pump. 
8.   Open mechanical pump vent valve. 
9. Open roughing valve. 
10.  After the diffusion pump has been off for 20 minutes, turn off cooling water 

 
Post-vent 

1. Disconnect crystal monitor cable. 
2. Remove substrate 
3. Remove Al top and glass cylinder and place carefully on table. 
4. Wipe Al from the glass with cleaning fluid and clean wipe. 
5. Place glass cylinder, Al top and substrate holder back on chamber. 
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APPENDIX F 
Vacuum Pumps 

 
There are two types of vacuum pumps used in the evaporator system, a mechanical (or 
rotary vane) pump and a diffusion pump.  Initially, the mechanical pump is used to 
“rough out” the main vacuum chamber, or pump it down to a pressure of 50 mTorr 
(atmospheric pressure is 760 Torr).  At that pressure, the diffusion pump is turned on and 
pumps the chamber down into “the sixes” or on the order of 10-6 Torr for evaporation.  
The mechanical pump “backs” the diffusion pump, or removes the exhaust of the 
diffusion pump so that it can function properly. 
 
Mechanical Pumps 

The operation of the mechanical pump is shown below.  The pump has a chamber and an 
off-axis cylinder that rotates inside.  There are two vanes that are spring-loaded such that 
they maintain contact with the wall of the chamber as the cylinder rotates.  Pump oil seals 
any small gap between the vanes and the cylinder wall.  At the start of the cycle, the vane 
marked P is near the intake port.  As the cylinder rotates clockwise, gas flows into the 
region behind P until this region is isolated from the intake port as shown in (c).  As the 
cylinder advances further, the gas is expelled through the exhaust port.  In this way, air is 
continually removed from any volume connected to the intake port. 
 

         
 
 

          

(a) (b) 

(c) (d) 

 

 XII 



Diffusion Pumps  

There are no moving parts in a diffusion pump, the heart of which is a tree-like structure 
called the “multistage jet assembly” (see diagram below).  A heater at the bottom of the 
pump boils the pump oil, and vapors travel upward inside the jet assembly.  The vapors 
are then accelerated out and downward through jet nozzles toward the outer walls of the 
pump.  The outer wall of the pump is cooled with cooling water, so that when the vapors 
strike the wall they condense and return to the bottom of the pump, completing the cycle.   
 
Gas molecules from the chamber diffuse into the pump at the inlet (top).  The high-speed 
oil jets collide with gas molecules and direct them downward into the bottom of the 
pump, where they are exhausted by a mechanical pump (attached at “Foreline pump 
connection”).  Diffusion pumps can achieve pressures of 10-8 Torr. 
 
Diffusion of the pump oil into the vacuum chamber can be prevented by placing a “cold 
trap” or a liquid nitrogen cooled baffle between the pump and the vacuum chamber.  This 
is done on our system.  Molecules that strike the surface of the baffle freeze to it and stay 
in the trap as long as it is supplied with liquid nitrogen. 
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